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About Perceptive Intelligent Capture
Perceptive Intelligent Capture (PIC) is a document processing system.

It combines optical character recognition (OCR), automatic data extraction from any document type, and
validation of that data against known data sources for auto-processing to your ECM system and other core
business applications.

Perceptive Intelligent Capture includes the following applications.

« Perceptive Intelligent Capture Designer

« Perceptive Intelligent Capture Runtime Server

« Perceptive Intelligent Capture Verifier

« Perceptive Intelligent Capture Web Verifier

For information about the document processing system, see About the Intelligent Capture process.

Prerequisites

To verify your system requirements and database meet the minimum requirements for PIC, refer to the

Perceptive Intelligent Capture Technical Specifications. Before you install PIC, verify the following

prerequisites.

« Ensure that you have local administrator rights and access to the Windows registry.

« Enable VBScript execution.

Optional

« Verify that you have installed Internet Information Services (IIS) on your server if your installation will
include PIC Web Verifier.

« Create the users and groups if you use the Microsoft-recommended resource rights assignment model.



About the Intelligent Capture process

Perceptive Intelligent Capture (PIC) analyzes text from any media type. It uses artificial neural network
techniques to automatically classify structured and unstructured documents and extract meaningful
information from them. Once a sample based learning method is employed PIC can handle information that is
similar to the samples without programming or extensive rule setting. PIC can operate at high speed and can
be implemented on parallel hardware to further enhance performance.

PIC forms a complete document processing system, as illustrated in the diagram below
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First, using capture, documents come into the process from a variety of sources.

Next, PIC recognizes all eligible data values on the page.



Then, PIC uses the extracted data to sort and classify the documents. Based on the document type, PIC
extracts field-level and line item level data. It does this without templates, anchors, keywords or zones.

Finally, PIC can validate extracted data against your business application data to ensure accuracy before
exporting it for workflow processing.

About the Perceptive Intelligent Capture database

The PIC installation process allows you to create the required database on your Microsoft SQL Server or
ORACLE server during the installation. You can also create the database separately after the PIC installation
procedure.

PIC stores the following data in the database.

« Documents

. Batches

« Project references

« Web Verifier configuration

« Batch and document lock handling

« Users, groups, roles, and relationships
« Application level user licensing

Verify SQL Server permissions

To use PIC with a SQL Server database, verify that your account has the following rights.

Note: You can use Windows authentication if the user performing the installation has the appropriate rights
to the database server.

+ Rights to create, modify, and delete tables.
« Rights to add, modify, and delete data.

Verify Oracle permissions

To use PIC with an ORACLE database, complete the following preparatory steps.

Note: You can use Windows authentication if the user performing the installation has administrative rights to
the database server.

1. Onyour ORACLE database, create a new instance with a meaningful name, such as Perceptive
Intelligent Capture.

2. Create a new user named Lexmark and assign a password to this user.
3. Assign the following rights to the user.

« Insert, modify, and delete data

o Create tables

« Create views
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Install Perceptive Intelligent Capture
Toinstall PIC, complete the following procedures.

« Download the setup package

o Optional. Modify the help file location

o Install PIC attended or Install PIC unattended

« Optional. Modify the application-specificHelpLink parameters
o Configure the database

« Copy the license file. For more information, see "Copy the license file to local license directories" in the
Perceptive Intelligent Capture Product Licensing Help.

o Configure Internet Information Services and Web Verifier, if the installation includes Web Verifier
« Configure PIC Security
« Configure PIC Runtime Components

Download the setup package
To obtain the installation files, complete the following steps.

1. Contact the Hyland Software Technical Support group at +1 (440) 788-5600.
2. Save and unzip the installation files locally so you can access them during installation.

About the complete and custom installation types
When you install PIC with an attended installation, you choose a complete or a custom installation type.

The complete option installs PIC Designer, Runtime Server, Verifier and Web Verifier in the [drive:]\[Program
directory]\[Installation directory] and creates the Perceptive Intelligent Capture program group. It also installs
the following recognition engines.

« FineReader 10
« FineReader 11
« Kadmos 5

o QualitySoft

The custom installation type allows you to choose which applications, demo projects, and recognition engines
you want to install. It also lets you select which programs you want to update automatically.



About Help files

By default, the Intelligent Capture products provide hosted product help, which enables you to always access
the most recent information directly from the documentation website. If your company’s network security
does not allow users to open a URL, you can download static help through the Customer Portal. To implement
static help instead of hosted help, you must modify the configuration.

The SetupType.ini file enables you to specify the path and file that the PIC application opens when you click
Help in the Help menu of a particular product. You can place the files on a web server and specify the URL to
the file that launches Help for that product or you can unzip the files on a local or a server drive, and use that
file path.

HelpLink parameters

You can redirect product help from the default web URLSs to a file on your system.

The HelpLink variable is a label that applies to a particular product. The products that provide help include:
Designer, RTS, Verifier, and Web Verifier.

The syntax includes the HelpLink type, which defines the product, and the path to the static file location.
HelpLink designer = [path]/PICD.htm

HelpLink rts = [path]/PICRS.htm

HelplLink verifier = [path]/PICV.htm

HelpLink webverifier = [path]/PICWV.htm

For path, supply the URL or path (absolute or relative) to the launch file for that specific help project. The
following examples show a URL, a network path, and a local path.

e HelplLink designer = https://docs.mycompany.com/mypath/Designer/PICD.htm
e HelpLink designer = \\myserver\mypath\Designer\PICD.htm

e HelpLink designer = C:/mypath/Designer/PICD.htm

Modify SetupType.ini for Help

To modify the SetupType.ini file, complete the following steps.

From the setup directory, open the SetupType.ini file with a text editor.

2. Inthe SetupType.ini file, in the [Help] section, specify the path for each HelpLink. The following lines
show sample URLs to the hosted documentation.

Example

HelpLink designer = https://docs.mycompany.com/PIC/en
US/5.8/Designer/PICD.htm HelpLink rts =
https://docs.mycompany.com/PIC/en US/5.8/Runtime Server/PICRS.htm
HelpLink verifier = https://docs.mycompany.com/PIC/en
US/5.8/Verifier/PICV.htm HelpLink webverifier =
https://docs.mycompany.com/PIC/en US/5.8/Web Verifier/PICWV.htm
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3. Saveand close thefile.

Install PIC attended

Toinstall PIC, complete the following steps.

1.

Run setup.exe.

Note: The installation process is available in English and German. The language used depends on the
regional settings of your system. The default language is English.

If NET Framework 4.5.2 is not installed, complete one of the following substeps.

« Tocancel the setup and install .NET Framework 4.5.2 manually, select Abort setup and then
click Next. After installing .NET Framework 4.5.2, rerun setup.exe and proceed with the following
steps.

o Toallow setup.exe toinstall .NET Framework 4.5.2, select Let the setup install .NET
Framework Version 4.5.2 (Recommended) and then click Next.

Inthe Setup Lexmark Perceptive Intelligent Capture page, click Next.

In the License Agreement page, read and accept the End-User License Agreement (EULA), and then
click Next.

In the Installation Type page, select Complete or Custom and click Next.

If you selected Custom, complete the following substeps. If you selected Complete, continue to the
next step.

1. Inthe Installation Directory page, accept the default or change the directory, and then click
Next.

2. Inthe Feature Selection page, clear any unrequired applications, demo projects, and recognition
engines and then click Next.

3. Optional. Inthe Configuration of Auto Update Feature page, select the programs you want to
update automatically.

4. The following option is currently not in use: Optional. In the Shared network updates directory
field, type or browse to a path.

Note: The path must exist. The installation process uses this path to create and configure the
batch files required for the automated update feature.

5. Click Next.

In the Program Folder page, accept the default program directory or select one of the existing
directories and then click Next.

In the Selected Install Options page, verify your selections and then click Next.

Inthe WIBU-KEY Runtime-Kit dialog box, click Yes.

In the Database Setup Options page, select one of the following options and then click Next.
« SQL Server

« Oracle

« Do not install database



Note: You can create the database separately after the PIC installation process.

11. For SQL Server or ORACLE, complete the following substeps.

1. Inthe Login Credentials page, either select Windows Authentication or type the user ID and
password and then click Next.

2. Inthe Database Server Information page, in the Database Server Name field, type the
database server name and then click Next.

12. Inthe Performed Tasks page, click Next.

13. Optional. Inthe Icons on Desktop page, select Create desktop shortcuts for applications and click
Finish.

Install PIC unattended

Toinstall PIC on several machines concurrently, such as PIC Verifier workstations, use the silent installation
mode.

Toinstall PIC silently, complete the following steps.
1. From the [drive:]\[setup directory] directory, open the Silent Install.ini file with a text editor.

2. Inthe Silent Install.ini file, change the parameters according to your needs.

Note: You can delete single parameters or complete sections, but you cannot move a parameter
outside of its appropriate section.

3. Save and close thefile.
4. From the [drive:]\[setup directory] directory, execute the setupsilent.bat file.

Silent Install.ini parameters

The following topics describe the parameters available in the Silent Install.ini file.

o [General]

o [Applications]

o [OCR Engines]

« [Additional]

o [AutoServiceUpdate]

« [Database Configuration]
« [DB Credentials]

[General]
This section contains general installation parameters.
Path

The installation path, without a trailing backslash.

Example
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Path = C:\Program Files\YourCompanyName

EULA
End-user license agreement
0: Accepted

1: Default value - Not accepted, the silent installation cancels

MoveComponentsifRequired

Indicates whether to use the existing component directory or to move any previous components to the
new PIC directory prior to installation.

0: Use existing component directory

1: Default value — Move components to the new directory

CreateDeskToplcons
0: Default value — do not create desktop shortcuts

1: Create desktop shortcuts

InstallWibuKey
0: Skip WIBU-key driver installation

1: Default value - install WIBU-key drivers

StoplfDotNetisNotFound
Web Verifier and the database connections require .NET Framework.

0: If the required .NET Framework is not present, the installation proceeds and automatically installs the
required version.

1: Default value - Cancel the installation if the required .NET Framework version is not present.

[Applications]
Defines which applications to install.
To install only the extraction components, set all parameters in this section to 0.
Designer
0: Don'tinstall PIC Designer

1: Default value — Install PIC Designer

Verifier
0: Don’t install PIC Verifier

1: Default value — Install PIC Verifier



Runtime Server
0: Don’t install PIC Runtime Server

1: Default value — Install PIC Runtime Server

Web Verifier
0: Don’t install PIC Web Verifier
1: Default value — Install PIC Web Verifier

[OCR Engines]

Defines which OCR engines to install.
FineReader10
0: Don't install the FineReader10 engine

1: Default value — Install FineReader10 engine

FineReader11
0: Don’t install the FineReader11 engine

1: Default value — Install FineReader11 engine

Kadmos5
0: Don't install the Kadmos 5 engine

1: Default value — Install Kadmos 5 engine

Cleqgs
0: Don'tinstall the Clegs engine

1: Default value — Install Clegs engine

QualitysoftBarcode
0: Don't install the QualitySoft engine

1: Default value — Install QualitySoft engine

[Additional]

Additional files to install.
Demo Files
0: Don't install the demo project files

1: Default value — Install the demo project files



[AutoServiceUpdate]

Defines whether the automatic service update feature installs.
ForDesigner
0: Default value — Don’t define an automatic service update for PIC Designer

1: Define an automatic service update for PIC Designer

ForVerifier
0: Default value — Don’t define an automatic service update for PIC Verifier

1: Define an automatic service update for PIC Verifier

NetworkUpdateFolder
The path where the automatic service update will look for updates.

The default value is an empty string.

[Database Configuration]

Settings for an existing database server.
DBServerType
1: Configure the SQL Server database
2: Configure the Oracle database

3: Default value — Don’t configure a database

UseDBConfiniFile
Path and filename of a text file that contains the database connection string.

The default value is an empty string. If you do not define a file, the installer uses the credentials in the
[DB Credentials] section. If the [DB Credentials] section does not exist, the DBServerType parameter
defaults to 3.

[DB Credentials]
You can use this section instead of defining a file in the parameter UseDBConflniFile.
Note: The database configuration skips, if the parameter UseDBConfIniFile contains an empty string.

The following options apply for SQL Server connections only.
SQLServerWindowsAuthent
0: Default value — Do not use Windows authentication for database access

1: Use Windows authentication for database access



SQLServerAdminUser

The DBA account name. The default value is an empty string.

SQLServerAdminPassword

The DBA account password. The default value is an empty string

The following options apply for both SQL Server and ORACLE connections.
DBUserWindowsAuthent
0: Default value — Do not use Windows authentication for database user

1: Use Windows authentication for the database user

DBUserName

The database user account name. The default value is an empty string.

DBUserPassword

The database user account password. The default value is an empty string.

DatabaseServerPath

The database name in the format <MachineName>\<InstanceName>. The default value is an empty
string.

Install an additional Runtime Server instance

To install an additional Runtime Server instance and connect it to an existing database, complete the
following steps.
1. Install PIC without installing the database.
2. Copy the following configuration files from an existing installation to the new installation directory.
« [Installation path]\Perceptive Intelligent Capture Web Server\Web.config
« [Installation path]\Perceptive Intelligent Capture\bin\DstDsr.exe.config
« [Installation path]\Perceptive Intelligent Capture\bin\DstHost.exe.config
« [Installation path\Perceptive Intelligent Capture\bin\DstSIm.exe.config
« [Installation path]\Perceptive Intelligent Capture\bin\DstVer.exe.config
[Installation path]\Perceptive Intelligent Capture\bin\DstWkBrw.exe.config

Perceptive Intelligent Capture subdirectories
Setup creates the following subdirectories in the installation directory.

« \Components\Bwe contains the PIC Toolkit.
« \Components\Cairo contains the license file and the base components for imaging and recognition.
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\Components\Cedar contains the base components for document analysis.

\Components\Tools contains the installation log file as well as several tools and utilities for PIC, such as
the SCBLibVersion.exe component version information tool

\Perceptive Intelligent Capture\bin contains the PIC executables and the settings files.
\Perceptive Intelligent Capture\bin\Log contains the log files.

\Perceptive Intelligent Capture Web Server contains the PIC web components, the Web.config file, and
other web libraries used by the Web Verifier.

\Projects contains demo projects.
\License contains the shared runtime license file.

Modify the application-specific HelpLink parameters

You can modify the application-specific HelpLink parameters if required. Complete the following steps.

1.

3.

From [Installation path]\Perceptive Intelligent Capture\bin, open the required configuration file,
such as DstDsr.exe.config for PIC Designer, in a text editor.

Search for the following line.
<add key="HelpLink"
Modify the value parameter according to your needs.

Install the database manually

Optional. If you did not install the database with the installation wizard, you can execute the scripts manually.

Complete one of the following tasks.

Create a SQL Server database
Create an Oracle database

Create a SQL Server database

To create a SQL Server database, complete the following steps.

A OWON =

Start the SQL Server Management Studio.
Log in using an account with administrator rights.
Create a new database with a meaningful name, such as Perceptive Intelligent Capture.

From the [drive:]\[setup directory]\FirstPart\Database\CreationScripts\SQL Server directory,
execute the BrwCreateDatabase.sql script.

From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\SQL Server directory, open
the BRW_Upgrade_Database.sql script.

Inthe BRW_Upgrade_Database.sql script, search for the term TargetDatabaseName and change
the term to the name of your PIC database.

Execute the BRW_Upgrade_Database.sql script.
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Create an Oracle database
To create an Oracle database, complete the following steps.

1. As an administrator, create a new tablespace and user for the BIC database.

Note:
The user name must be all-uppercase.

2. Start SQL*Plus or the ORACLE Management Console.

3. From the [drive:]\[setup directory]\FirstPart\Database\CreationScripts\Oracle directory, execute
the BrwCreateDatabase.sql script.

4. From the [drive:]\[setup directory]\FirstPart\Database\UpdateScripts\Oracle directory, open the
BRW_Upgrade_Database.sql script.

5. Inthe BRW_Upgrade_Database.sql script, search for the term Target DBSchemaName and change
it to the name of the user associated to the PIC database.

6. Executethe BRW_Upgrade_Database.sql script.
Configure the database

After you have installed the database, through the installer or by manually running the scripts, you must
configure it. Complete the following tasks.

1. Modify the database connection strings

2. Optional. Encrypt the password for a database connection string

3. Ifyouuse PIC with an Oracle database, Modify the .NET configuration for Oracle

Modify the database connection strings
To modify the database connection strings for Web Verifier, see “Modify the database connection strings for
Web Verifier”.
To modify the database connection strings for all PIC components, except Web Verifier, complete the
following steps.
1. From the [Installation path]\Perceptive Intelligent Capture\bin directory, open DstDsr.exe.config
in a text editor.
2. Searchforthe <connectionStrings> element.
3. ForaSQL Server database, modify the following values.
o SetData Source tothe data source.
« SetInitial Catalogtothe SQL Serverdatabase catalog.
o SetUser IDtothe SQL ServeruserID.
o Set Password tothe SQL Server password.

Example

<connectionStrings> <add name="Entities"
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connectionString="metadata=res://*/Entity.Entities.csdl|res://*/Entity
.Entities.ssdl|r es://*/Entity.Entities.msl;
provider=System.Data.SglClient;provider connection string=&quot;Data
Source=<DataSource>;Initial
Catalog=<SQLServerDatabaseCatalog>; Integrated Security=false;User
ID=<UserId>;Password=<UserPassword>;MultipleActiveResultSets=True&quo
t;" providerName="System.Data.EntityClient" /> </connectionStrings>

Note: To copy the connections string example as a single line, open this document in Acrobat Reader
and copy and paste the string from there.

For an ORACLE database, modify the following values.
o SetData Source tothe data source.

o SetUser IDtothe serviceaccountuserID.

« Set Password tothe service account password.

Example

<connectionStrings> <add name="Entities"
connectionString="metadata=res://*/Entity.ORAEntities.csdl|res://*/Ent
ity.ORAEntities. ssdl|res://*/Entity.ORAEntities.msl;
provider=EFOracleProvider; Provider Connection String='Data
Source=<OracleServerName\InstanceName>; User
ID=<UserID>;Password=<UserPassword>""
providerName="System.Data.EntityClient" /> </connectionStrings>

Note: To copy the connections string example as a single line, open this document in Acrobat Reader
and copy and paste the string from there.

Save and close the file.

Repeat the previous steps for the following configuration files.
« Brainware.System.Project.exe.config

« DstSIm.exe.config

« DstVer.exe.config

« DstHost.exe.config

« DstWkBrw.exe.config

Encrypt the password for a database connection string

Password encryption in configuration files is optional, but highly recommended.

To provide an encrypted password for the database connection in a configuration file, complete the following
steps.

1.

To create an encrypted password, complete the following substeps.

1. Inthe [Installation pathj\Perceptive Intelligent Capture\bin directory, create a new batch file
and give it a meaningful name, such as CreateEncryptedPassword.bat.
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2. Copy the following line to the batch file, replacing MyPassword with the password you want to

encrgpt.
DstCrypt.exe /text MyPassword > EncryptedPassword.txt

Note: The maximum password length is 30 characters.

3. Save and close thefile.
In Windows Explorer, double-click the batch file.

5. From [Installation pathJ\Perceptive Intelligent Capture\bin, open EncryptedPassword.txt in
a text editor and copy the encrypted password to the clipboard.

2. From [Installation path]\Perceptive Intelligent Capture\bin, open the required configuration file,
such as DstDsr.exe.config for PIC Designer, in a text editor.

3. Searchforthe <connectionStrings> element.
4. Inthe <add name> element, set password as an asterisk.

Example
<add name="Entities" Password=*>

5. Inthe <appSettings> element, add a line with your encrypted password according to the following
example

Example

<appSettings> <add key="EncrPwd" value="The encrypted Password"/>
</appSettings>
6. Save and close the DstDsr.exe.config file.
7. Optional. Repeat the previous steps for one or all of the following configuration files.
« For Runtime Server: [Installation path]\Perceptive Intelligent Capture\bin\DstHost.exe.config

« ForLearnset Manager tool: [Installation path)\Perceptive Intelligent
Capture\bin\DstSIm.exe.config

« For Verifier: [Installation path]\Perceptive Intelligent Capture\bin\DstVer.exe.config

« ForWorkdoc Browser: [Installation path)\Perceptive Intelligent
Capture\bin\DstWkBrw.exe.config

« For Supervised Learning in Web Verifier: [Installation path]\Perceptive Intelligent
Capture\bin\Brainware.System.Project.exe.config

« For Web Verifier: [Installation path]\Perceptive Intelligent Capture Web Server\web.config

Modify the .NET configuration for Oracle
If you use PIC with an Oracle database, complete the following steps.

1. From <drive>:\WIND OWS\Microsoft. NE T\Framework\v4.0.30319\CONFIG, open machine.config in
a text editor.
2. Searchforthe <system.data> element.

3. Underthe <DbProviderFactories> element, verify or add the following element.
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Example

<add name="EF Oracle Data Provider" invariant="EFOracleProvider"
description="EF Provider for Oracle testing”
type="EFOracleProvider.EFOracleProviderFactory, EFOracleProvider,
Version=1.0.0.0, Culture=neutral, PublicKeyToken=def642f226e0e59%90"/>

Note: To copy this example as a single line, open this document in Acrobat Reader and copy and
paste the string from there.

4. Save and close thefile.

The PIC Components Version Info tool

The PIC Components Version Info tool provides information about the installed DLLs and the components
that require an entry in the license file to be available.

Components General Info view

This view lists the installed primary DLLs and provides the following information.

See also: Review the installed components

Name. Name of the installed DLL.

Description. Description of the DLL.

Build. Build number of the DLL.

Product version. Version of the DLL.

Date. Compilation date and time.

Build Date Time. Date and time the build was created.
Install Directory. Path to the component location.

Components Licensing Info view

This view lists licensable components and provides the following information.

See also: Review the component license information

Component Name. Name of the component.
Component Type. Type of the component.
Status. License status of the component.
License File Path. License file location.

License Files. License file name.

Expires. License expiration date for component.
Version. Version number.

Customer. Customer name.

Customer ID. Customer ID.

Serial. Serial number.
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Review the installed components
Toreview the installed components, complete the following steps.

Start the Components Version Info tool.
To display the list of installed components, click View > Components General Info.
Optional. To copy the displayed information to the clipboard, click File > Copy to Clipboard.

A ON -

Optional. To save the displayed information to afile, click File > Save to File.

Review the component license information
To review the component license information, complete the following steps.
1. Start the Components Version Info tool.

2. Todisplay the license information, click View > Components Licensing Info.

Manage the PIC components
To manage the PIC components, complete any of the following tasks as necessary.

o Manually register components
o Add or remove PIC components

Manually register components

The installation process automatically registers the Cro*.dll, Cdr*.dll, and Bwe*.dll components. For
troubleshooting purposes, you can manually register these components. To register the components,
complete the following steps.

1. From the [installation path]\Perceptive Intelligent Capture\Components\Cairo directory, execute the
RegCro.bat file.

2. From the [Installation path]\Perceptive Intelligent Capture\Components\Cedar directory, execute the
RegCdr.bat file.

3. From the [Installation path]\Perceptive Intelligent Capture\Components\Bwe directory, execute the
RegBwe.bat file.

Add or remove PIC components
The PIC installation process enables you to add or remove the following components.

o Perceptive Intelligent Capture Designer

» Perceptive Intelligent Capture Runtime Server
o Perceptive Intelligent Capture Verifier

o Perceptive Intelligent Capture Web Verifier

1. From Windows Programs and Features, select Perceptive Intelligent Capture and then click
Change.
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In the License Agreement page, read and accept the End-User License Agreement (EULA), and then
click Next.

In the Setup page, select Modify and then click Next.

In the Feature Selection page, select or clear the desired components and then click Next.
In the Icons on Desktop page, complete the following substeps.

1. Optional. Select Create desktop shortcuts for applications.

2. Click Finish.

Configuration for Web Verifier

Your Internet Information Server (11S) executes Web Verifier.
To configure [IS and Web Verifier, complete the following tasks as necessary.

Configure IIS for Web Verifier

Configure Web Verifier

Configure server security for Web Verifier
Configure Internet Explorer for Web Verifier
Optional. Implement single sign-on authentication
Optional. Configure Windows authentication

Optional. Configure SSL. For information on how to configure SSL on your IIS machine, refer to
http://support.microsoft.com.

Optional. Configure cookies for Web Verifier

Configure IIS for Web Verifier

To configure |IS for Web Verifier, complete the following tasks.

Ensure that the required role services are enabled.
Create an application pool for PIC in IIS 7.5 and above
Configure PIC in lIS 7.5 and above

Configure a white label directory in 11S

Role services configuration for Web Verifier in IS 7.5 and above

Web Verifier requires the following role services in I1S.

Common HTTP Features

Static Content
Default Document
Directory Browsing
HTTP Errors
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Application Development

« ASP.NET4.5

« .NET Extensibility
« ISAPI Extensions
« ISAPI Filters

Health and Diagnostics

« HTTP Logging
« Request Monitor

Create an application pool for PIC in IIS 7.5 and above

To create an application pool, complete the following steps.

1. Start Internet Information Services (1IS) Manager.

2. IntheInternet Information Services (1IS) Manager window, in the left pane, right-click the local
computer and then click Switch to Content View.

3. Inthe middle pane, right-click Application Pools and then click Add Application Pool.
4. Inthe Add Application Pool dialog box, complete the following substeps.
1. Inthe Namefield, type WebVerifierPool.
2. Fromthe .NET CLR version list, select NET CLR v4.0.30319 and then click OK.
5. Inthe left pane, click Application Pools.
6. Inthe middle pane, right-click WebVerifierPool and then click Advanced Settings.
7. Inthe Advanced Settings dialog box, provide the following settings and then click OK.
« Enable 32-Bit Applications = True
« Managed Pipeline Mode = Integrated
« ldentity = NetworkService
« Load User Profile = True

Configure PIC in IIS 7.5 and above

To configure PIC in IS 7.5 and above, complete the following steps.

Start Internet Information Services (IIS) Manager.

2. IntheInternet Information Services (IIS) Manager window, in the left pane, expand Sites > Default
Web Site.

3. Right-click Default Web Site and then click Add Application.
4. Inthe Add Application dialog box, complete the following substeps.
1. Inthe Alias field, type Wiebverifier.

2. Inthe Application pool field, select the pool that was configured before, such as
WebVerifierPool.



3. Inthe Physical path field, type or browse to the [Installation pathj\Perceptive Intelligent
Capture Web Server directory and then click OK.

In the Internet Information Services (11IS) Manager window, in the left pane, select WebVerifier.
In the middle pane, under IIS, double-click Default Document.

In the right pane, click Add.

In the Add Default Document dialog box, in the Name field, type Login . aspx and then click OK.
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Configure a white label directory in IIS

If you are using a PIC version that contains a white label (WL) directory inside the Components\Cedar
directory, create a WL virtual directory in [IS. Complete the following steps.

1. Inthe Internet Information Services (IIS) Manager window, in the left pane, open the tree view until
Web Verifier displays.

2. Right-click Web Verifier, then click Add Virtual Directory.

3. Inthe Add Virtual Directory dialog box, complete the following substeps.
1. Inthe Alias field, type WL as the name for the virtual directory.

2. Inthe Physical path field, type or browse to the [Installation path]\Perceptive Intelligent
Capture\Components\Cedar\WL directory and then click OK.

Configure Web Verifier
To configure Web Verifier, complete the following tasks.

Set the path to the license file
Modify the instanceName when using multiple web servers
Modify the database connection strings for Web Verifier

A OON -

To enhance application performance, you can optionally enable HTTP compression. For more
information, refer to Microsoft Technet.

Set the path to the license file

To set the path to the license file, complete the following steps.

1. From the [installation path]\Perceptive Intelligent Capture Web Server directory, open Web.config in a
text editor.

2. Search for the following line. . . .
<project licensePath="[Installation path]\Perceptive Intelligent

Capture\License\Runtime.lic"
3. Setthe 1icensePath value to yourlicense file location.
4. Save and close thefile.
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Modify the instanceName when using multiple web servers

To ensure that the instanceName value in the Web.config is unique across all web servers accessing the
same PIC database, complete the following steps.

1.

From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open Web.config in a
text editor.

Search for the following XML elements. o
<system.controllers><client instanceName="Web Verifier"

remoteObjectRenewalTimeout="180"></client>.

Change instanceName="Web Verifier"toinstanceName="Web Verifier [xx]" withxx
being unique across the system.

Example instanceName="Web Verifier 01" forthefirstserver.

Example instanceName="Web Verifier 02" forthe second server.

Modify the database connection strings for Web Verifier

To modify the database connection string, complete the following steps.

1.

7.

From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

Search forthe <connectionStrings> element.

For a SQL Server database, modify the following values.
« Set Data Source to the data source.

« SetInitial Catalog to the SQL Server database catalog.
« Set User ID to the service account user ID.

« Set Password to the service account password.

For an ORACLE database, modify the following values.
« Set Data Source to the data source.

« Set User ID to the service account user ID.

« Set Password to the service account password.
Save and close thefile.

Create a copy of the Web.config file and move it to [Installation path)\Perceptive Intelligent
Capture\bin.

Rename the Web.config file copy to Brainware.System.Project.exe.config.

Configure server security for Web Verifier

To configure server security for Web Verifier, complete the following tasks as necessary.

1.
2.
3.

Add the user context in SQL Server
Verify the IS settings
Set permissions for PIC projects
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Add the user contextin SQL Server

To use Web Verifier, your users need access rights for the SQL Server database with the Web Verifier user
context. The default user context is Network Service.

Note: If you log in to the SQL Server using Windows authentication, you need to add the domain username
to the SQL Server database in addition to the NT Authority/Network Service.

To add the Network Service user context to the SQL Server, complete the following steps.

In Microsoft SQL Server Management Studio, in the left pane, click Security > Logins.
Right-click Logins and then click New Login.
In the Login dialog box, click Search.
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In the Select User or Group dialog box, in the Enter the object name to selectfield, type NETWORK
SERVICE, click Check Names and then click OK.

In the Login dialog box, in the left pane, click Server Roles.

o O

In the right pane, under Server roles, select sysadmin and then click OK.
Verify the IIS settings

To verify that the IS runs under NT Authority\Network Service, complete the following steps.

1. InInternet Information Services (IIS) Manager, in the Connections pane, open the server node and
then click Application Pools.

2. Inthe Application Pools pane, right-click Web Verifier Pool and then click Advanced Settings.

3. Inthe Advanced Settings dialog box, under Process Model, verify that the Identity property has the
value NetworkService.

Set permissions for PIC projects

PIC stores all projects in a file system directory. To enable the Web Verifier to load projects, you must assign
appropriate permissions for the project directory.

To grant permission to the Network Service user for the project directory, complete the following steps.

InWindows Explorer, right-click your projects directory and then click Properties.
In the Properties dialog box, on the Security tab, click Edit.
In the Permissions dialog box, click Add.
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In the Select Users, Computers, Service Accounts, or Groups dialog box, in the Enter the object
names to select field, type NETWORK SERVICE, click Check Names and then click OK.

Configure Internet Explorer for Web Verifier
To configure Internet Explorer for Web Verifier, complete the following steps.

1. InlInternet Explorer, click Tools > Internet Options.
2. Ininternet Options dialog box, on the Security tab, click Custom level.
3. Inthe Security Settings dialog box, under ActiveX controls and plug-ins, enable the following



settings.
« Binary and script behaviors
« Run ActiveX controls and plug-ins
4. Under Scripting, enable the following settings.
« Active scripting
« Allow status bar updates via script

Note: This setting allows Web Verifier to display information on batches, documents, current filters,
and page numbers in the Internet Explorer status bar.

Implement single sign-on authentication

To enable single sign-on authentication, complete the following tasks as necessary.
1. Enable the single sign-on authentication
2. Modify the Web Verifier session timeout

About the single sign-on authentication for Web Verifier

Web Verifier supports single sign-on (SSO) user authentication. SSO intercepts the login request and either
gathers the user credentials, or accepts the user as already authenticated.

PIC provides the SSO functionality as a generic solution. It works with any SSO implementation and
configuration that provides the user credential information through an HTTP header.

For information on configuring the SSO service provider, refer to your provider's product documentation.
Enable the single sign-on authentication

To enable single sign-on authentication, complete the following steps.

1. From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

2. Searchforthe <httpHeaderBasedSso> element and complete the following substeps.
1. Setthe enabled attribute to true.
2. Setthe loginHeader attribute to the HTTP header attribute name that the SSO service retumns.
3. Setthe sessionHeader attribute to the default session-ID header that the SSO service retumns.

Example

<httpHeaderBasedSso loginHeader="remoteuser" enabled="true"
sessionHeader="ShibSessionID" />

3. Saveandclose thefile.
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About the single sign-on session and the Web Verifier session

Using SSO involves two different sessions: the SSO session and the Web Verifier session.
To prevent verifier data loss, the SSO session should have a longer timeout than the Web Verifier session.

The SSO and Web Verifier sessions renew with every server request, such as field validation or opening a
batch. The sessions do not renew with client-side actions, such as zooming in on an image or typing a value
into a form field without validating it.

For details on how to configure the SSO session timeout, refer to your SSO provider documentation.
Modify the Web Verifier session timeout

To modify the Web Verifier session timeout, complete the following steps.

1. From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

2. Searchforthe <sessionState> element.
3. Setthe timeout attribute, in minutes, according to your needs.

Configure Windows authentication
To configure Windows authentication, complete the following tasks as necessary.

1. Configure Windows authentication in IS 7.5 and higher
2. Create a Windows authentication-version of the Web.config file
3. Switch back to Forms authentication

About Windows authentication for Web Verifier

Web Verifier allows you to log in using Windows authentication instead of Forms authentication.
After you configure this option, your users will only be able to log in with Windows authentication.

However, you can use the re-login menu option to login with an account other than your Windows user
account, for example as an administrator, to perform certain administrative tasks.

Configure Windows authentication in IS 7.5 and higher

To configure Windows authentication for the Web Verifier in [IS 7.5 and higher, complete the following steps.

Prerequisite
Add the Windows user to the PIC database.

1. Inthe Internet Information Services (IIS) Manager window, in the left pane, open the tree view until
Web Verifier displays.

2. Click Web Verifier and then, in the middle pane, under lIS, double-click Authentication.

3. Inthe Authentication pane, enable Windows Authentication and disable all other authentication
methods.

4. Restart any open browser sessions.
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Create a Windows authentication-version of the Web.config file

We recommend maintaining two versions of the Web.config file to simplify switching between the default
Forms authentication and Windows authentication methods.

To create a copy of the default Web.config file and modify it for Windows authentication, complete the
following steps.

1.

From the [Installation path]\Perceptive Intelligent Capture Web Server directory, create a backup of the
Web.config file for the Forms authentication method.

Note: You can store this backup Web.config for Forms authentication in any directory.

Open the original Web.config file in a text editor.
Complete the following substeps.

1. Search for the following line.
<authentication mode="Forms">

2. Replace Forms withWindows.
<authentication mode="Windows">

3. Removethefollowingline. _
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />

4. Underthe <authorization> node, replace the <deny users="7?"/> element with an
<allow users="7?"/>element.

5. Underthe <pages> node, add an <pages enableSessionState="true"> element.
6. Removeall <location path=>nodes.
7. Save and close thefile.

Switch back to Forms authentication

To switch from Windows authentication mode back to default Forms authentication, complete the following

steps.

1. Open Administrative Tools and then double-click Internet Information Services (IIS) Manager.

2. IntheInternet Information Services (IIS) Manager window, in the left pane, open the tree view until
Web Verifier displays.

3. Click WebVerifier and then, in the middle pane, under lIS, double-click Authentication.

4. Inthe Authentication pane, disable Windows Authentication and enable Anonymous
Authentication and Forms Authentication.

5. Copy the backed up Web.config file to the [Installation path]\Perceptive Intelligent Capture Web
Server directory.

6. Restart any open browser sessions.



Configure cookies for Web Verifier

To ensure that the browser sends cookies over a secure https network only, complete the following steps.

Prerequisite
Configure SSL on the server.

1.

From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

Inthe <configuration> element, search for the following line.
<system.web>

Under <system.web>, add the following line.
<httpCookies requireSSL="true" />

To apply forms authentication, search for the following line. .
<forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx" />

Add the requireSsL attribute.

Example <forms loginUrl="Login.aspx" defaultUrl="BatchView.aspx"
requireSSL="true" />

Save and close the file.

Optional. To prevent other applications from accessing Web Verifier cookies, deploy Web Verifier in
one of the following ways.

« As the root level website.
« As the only web application under a website in |1S.

Use Traditional Chinese

If you choose Chinese as Ul language, Web Verifier uses Simplified Chinese by default.
To change to Traditional Chinese, complete the following steps.

1.

From the [Installation path]\Perceptive Intelligent Capture Web Servenbin\Resources directory, create
a backup copy of the zho directory.

Copy all files from the [Installation path]\Perceptive Intelligent Capture Web Servenbin\Resources\cmn
directory to the [Installation path]Perceptive Intelligent Capture Web Server\bin\Resources\zho
directory.

From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

Search for the following line. e
<add key="LanguageDisplayName ZHO" value=""H 3 fijfk" />

Modify the line as follows. N
<add” key="LanguageDisplayName CMN" value=""HCZ " />

Save and close the file.
Restart any open browser sessions.
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Access the PIC Web Verifier

To access PIC Web Verifier, complete the following step.

o Inyourbrowser, type http://localhost/WebVerifier/login.aspx.

Additional columns in Verifier or Web Verifier

You can display additional columns in Verifier and Web Verifier. If you display the external group ID column,
verify that the group ID matches the group ID you created for the users.

You can add the following columns to batch view.

« ExternalGroupld
« ExternalBatchld
« Transactionld

« TransactionType

Display and name additional Verifier columns: SQL Server

To display additional Verifier columns from a SQL database, in Microsoft SQL Server Management Studio, in
your PIC database, modify and execute any of the following commands.
« External group ID . . .
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalGroupId', '
[Column header name, for example User Group]', True

External batch ID . . .
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnExternalBatchIid', '

[Column header name, for example Batch Group]', True

« Transaction ID . . . .
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionId', '

[Column header name, for example Transaction]', True

« Transaction type . . . .
exec sp_SetGlobalApplicationSetting 'SysAppBatchColumnTransactionType', '

[Column header name, for example Transaction Type]', True
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Display and name additional Verifier columns: Oracle

To display additional Verifier columns from an Oracle database, from the SQL*Plus or ORACLE Management
Console, in your PIC database, execute any of the following commands.

« External group ID . . .
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnExternalGroupId',

'[Column header name, for example User Group]', 1)

o External batch ID . . .
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnExternalBatchId',

'[Column header name, for example Batch Group]', 1)

« Transaction ID . . . .
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnTransactionId', '

[Column header name, for example Transaction]', 1)

o Transaction type , , , .
exec sp_SetGlobalApplicationSetting ('SysAppBatchColumnTransactionType',

'[Column header name, for example Transaction Typel, 1)
Display additional Web Verifier columns

The PostimportBatch event in the project script displays additional Web Verifier columns.

For more information on the event, see “PostimportBatch” in the Perceptive Intelligent Capture Scripting Help.

To display additional columns in Web Verifier, complete the following steps.

1. From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open the Web.config
file in a text editor.

2. Search for the following elements and set the visible attribute to t rue for the columns you want to
display.

« externalGroupldColumn
« externalBatchNameColumn
« transactionldColumn
« transactionTypeColumn
3. Save and close thefile.
4. Restart any open browser sessions.

Change the Web Verifier column names

To change the display names for any additional columns in Web Verifier, complete the following steps.
1. From the [Installation path]\Perceptive Intelligent Capture Web Server\bin\resources\[language code]
directory, open the Brainware.Verifier.WebClient.resx file in a text editor.
2. Search for the following <data name=> elements.
o« TEXT_EXTERNALBATCH_NAME
o« TEXT_EXTERNAL_GROUP_ID
o« TEXT _TRANSACTION_ID
o« TEXT_TRANSACTION_TYPE
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3. Setthe <value> attributes with the names you want to display.
4. Save and close thefile.
5. Restart any open browser sessions.

Configure global application settings

To configure global application settings, complete the following tasks as necessary.

1. Optional. Configure workflow history reporting for SQL Server or Oracle.
2. Optional. Disable batch deletion for SQL Server or Oracle.
3. Optional. Modify the URL expiration time for SQL Server or Oracle.

About workflow history reporting

You can activate the workflow history reporting for documents, fields, table cells, classification, leaming, and
OCR and document separation. Changing these settings takes immediate effect and applies to all users.

Configure workflow history reporting: SQL Server

To configure workflow history reporting for SQL Server, in Microsoft SQL Server Management Studio, in your
PIC database, execute any of the following commands.

« Fordocuments . . .
exec sp_SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForDocument', 'True', True

o Forfields . . .
exec sp_SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForField', 'True', True

» Forfields and table cells . . .
exec sp_ SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForTableCell', 'True', True

» Forclassification . . .
exec sp_ SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForClass', 'True', True

o For OCR and document separation .
exec sp_ SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForPage', 'True', True

« Forlearning . . .
exec sp_SetGlobalApplicationSetting

'SysAppHistoryReportingActivatedForLearning', 'True', True

36



Configure workflow history reporting: Oracle

To configure workflow history reporting for Oracle, in SQL*Plus or Oracle Management Console, in your PIC
database, execute any of the following commands.

« Fordocuments . . .
exec sp_SetGlobalApplicationSetting

('SysAppHistoryReportingActivatedForDocument', 'True', 1)

o Forfields . . .
exec sp_SetGlobalApplicationSetting

('SysAppHistoryReportingActivatedForField', 'True', 1)

o Forfields and table cells . . ,
exec sp_SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForTableCell', 'True', 1)

« Forclassification . . .
exec sp_SetGlobalApplicationSetting

('SysAppHistoryReportingActivatedForClass', 'True', 1)

« For OCR and document separation .
exec sp_SetGlobalApplicationSetting

('SysAppHistoryReportingActivatedForPage', 'True', 1)

« Forlearning . . .
exec sp_ SetGlobalApplicationSetting
('SysAppHistoryReportingActivatedForLearning', 'True', 1)

About disabling batch deletion in Runtime Server and Designer

You can disable batch deletion in Runtime Server and Designer. Changing these settings takes immediate
effect and applies to all users.

Disable batch deletion: SQL Server

To disable batch deletion for SQL Server, in Microsoft SQL Server Management Studio, in your PIC database,
execute any of the following commands.

« ForDesigner . . .
exec sp_SetGlobalApplicationSetting

'SysAppBatchDeletionDisabledInDesigner', 'True', True

« ForRuntime Server , , , , ,
exec sp_SetGlobalApplicationSetting 'SysAppBatchDeletionDisabledInRTS',

'True', True

Disable batch deletion: Oracle

To disable batch deletion for Oracle, in SQL*Plus or Oracle Management Console, in your PIC database,
execute any of the following commands.

« ForDesigner . . .
exec sp_SetGlobalApplicationSetting

('SysAppBatchDeletionDisabledInDesigner', 'True', 1)

» ForRuntime Server . . . . .
exec sp_ SetGlobalApplicationSetting ('SysAppBatchDeletionDisabledInRTS',

'"True', 1)
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About modifying the URL expiration time for Web Verifier

You can modify the URL expiration time for Web Verifier. Changing these settings takes immediate effect and
applies to all users.

Modify the URL expiration time: SQL Server

To modify the URL expiration time for SQL Server, in Microsoft SQL Server Management Studio, in your PIC
database, complete the following step.

« Execute the following command, specifg/in the expiration time in seconds for the second parameter.
exec sp_SetGlobalApplicationSetting 'SysAppUrlSignatureExpirationPeriod’',

'300', True

Modify the URL expiration time: Oracle

To modify the URL expiration time for Oracle, in SQL*Plus or Oracle Management Console, in your PIC
database, complete the following step.

« Execute the following command, specifging the expiration time in seconds for the second parameter.
exec sp_SetGlobalApplicationSetting

('SysAppUrlSignatureExpirationPeriod', '300', 1)

Configure PIC security
To configure PIC security, review the following topics and complete the tasks as necessary.

File system security

Recommended accounts and groups

Configure access to project data

About the service account on a domain network
About the service account for system monitoring
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About the service account for email importing

File system security

Although PIC provides application-level security, the PIC applications rely on the integrated Windows file
system security to control access to application and project data in SDP, DAT, and WDC files.

PIC uses a combination of shared and file and directory permissions to control the access of users, groups,
and applications to directories and files.

The following table lists the available file permissions.

File Access Granted

Permission

Read Allows the user or group to read the file and view its attributes, ownership, and
permissions.




File

Access Granted

Permission

Write Allows the user or group to overwrite the file, change its attributes, and view its ownership
and its permissions.

Read and Allows the user or group to execute the file.

Execute Includes the Read permissions.

Modify Allows the user or group to modify and delete the file.

(CHANGE) Includes the Read, Write, and Read and Execute permissions.

Full Control Allows the user or group to change the files permissions and to take ownership of the file.

Includes all other file permissions.

The following table lists the available directory permissions.

Directory Access Granted

Permission

Read Allows the user or group to view the files, folders, and subfolders of the parent folder and to
view the folder attributes, ownership, and permissions.

Write Allows the user or group to create new files and folders within the parent folder, view folder
ownership and permissions, and change folder attributes.

List Folder Allows the user or group to view the files and subfolders in the folder.

Content

Read and Allows the user or group to navigate through all files and subfolders.

Execute Includes the Read and List Folder Contents permissions.

Modify Allows the user to delete the folder.

(CHANGE) Includes the Write and Read and Execute permissions.

Full Control Allows the user or group to change the folder permissions and to take ownership of the

folder.
Includes all other folder permissions.




Recommended accounts and groups

To control access to PIC project data, we recommend a combination of Discretionary Access Control (DAC)
and Role-based Access Control (RBAC).

The DAC model allows the system administrators to control which users can access objects and resources
and the operations they can perform.

The RBAC model, also known as non-discretionary model, grants access based on the rights and
permissions of roles and groups. The users inherit their rights and permissions from their assigned roles and
groups.

The following table lists the groups and accounts recommended for each PIC implementation.

Group / Purpose

Account

Name

PIC Global group containing all users designated as PIC project designer or data verifier. Add this
Project group to the PIC Users group.

Users

PIC Admin | Global group containing all users designated as a PIC system administrator. Add this group to
the PIC group on all RTS servers and RTS remote administration workstations.

PIC Local group used to grant access to local PIC resources. Create this group on all RTS server
and RTS remote administration workstations.

PIC Users Local group used to grant access to the project directory. Create this group on the PIC server
on which the project directory resides.

PIC Service account used to start the PIC service manager. Add this user to the PIC Admin group
RTSsvc and the local administrators group on all PIC servers and remote administration workstations.

The following table lists the groups and accounts, assigned permissions, and the directories and objects on
which you need to apply the permissions for each PIC implementation.

Group / Account Name | Permission Type: | Permission Directory/Objects Assigned
Shared Type: NTFS On

Perceptive Intelligent Full Control Full Control C:\Program Files\[company]\

Capture [ProjectName]

Perceptive Intelligent Change Modify C:\Program Files\[company]\

Capture Users [ProjectName]




Configure access to project data

PIC uses a hierarchical file structure to store project-related data, where the project directory is at the highest
level.

All PIC components including services, applications, license engines, and users need appropriate access
rights to the project directory and its subfolders.

To configure the access rights to the PIC project directory, complete the following steps.

In Windows Explorer, right-click your projects directory and then click Properties.
In the Properties dialog box, on the Sharing tab, click Advanced Sharing.

In the Advanced Sharing dialog box, select Share this folder.

In the Share name box, type a name for the share and then click Permissions.
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In the Permissions for Projects dialog box, complete the following substeps.
1. Click Add.

2. Inthe Select Users, computers, Service Accounts or Groups dialog box, in the Enter the
object names to select field, type the local PIC group name and click OK.

3. Repeat the previous steps to add the local administrators and PIC users group names.
4. Forthe local PIC group and the local administrators group, select Full Control.
5. Forthe local PIC users group, select Change.
6. Select the Everyone group, click Remove and then click OK.
6. Inthe Properties dialog box, on the Security tab, complete the following substeps.
1. Add the local PIC group and the local administrators group with Full Control permission.
2. Addthe local PIC users group with Change permission.
3. Select the Everyone group, click Remove and then click OK.

About the service account on a domain network

The PIC Runtime Server service utilizes a Windows service to manage the Runtime Server instances and the
document processing.

When running PIC on multiple servers located on a domain network, we recommend assigning a domain user
to the PIC Runtime Server service against the Windows service. This allows PIC to communicate with all
servers running the service across the domain.

The service account, used in PIC, needs permissions for any file or directory shares across the servers to
allow the PIC Runtime Server service to access all project-related files.

Note: Do not use the service account to log into the system, either locally or through Remote Desktop. You
can configure the Security Settings for the “Deny log on locally” and “Deny log on through Remote Desktop
Services” policies in Windows on the system running the services.



About the service account for system monitoring

You can use the System Monitoring service to send emails to selected users for any Runtime Server errors or
warnings.

The service user account used for System Monitoring needs sufficient rights on the server and domain to
send emails.

About the service account for email importing

PIC provides the ability to import emails, automatically download emails from a mailbox, and import the
emails into the PIC system. The PIC Runtime Server service needs sufficient access rights to access the
mailbox and to download emails.

Configure PIC Runtime Components
To configure PIC runtime components, review the following topics and complete the tasks as necessary.

About RTS Remote Administration MMC

Configure the PIC Runtime Service Manager service
Configure the RTS Remote Administration MMC Snap-in
Configure the email import feature in Microsoft Outlook

About RTS Remote Administration MMC

Before you can use PIC, you must configure the Runtime Service Manager (RTS).
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The RTS Remote Administration Microsoft Management Console (MMC) snap-in enables you to start and
stop multiple PIC Runtime Servers remotely from a single workstation on the network. The PIC installation
creates a default console, called Runtime Server Administration that you can use to configure the RTS
Remote Administration MMC snap-in.

Configure the PIC Runtime Service Manager service
To configure the PIC Runtime Service Manager service, complete the following steps.

Prerequisite
Verify that the PIC RTSsvc domain user exists.

1. LogintoWindows using an account with administrator rights.

2. InWindows Services, right-click the Perceptive Intelligent Capture Runtime Service Manager
service and then click Properties.

3. Inthe Perceptive Intelligent Capture Service Manager Properties dialog box, on the General tab,
set the Startup type according to your needs.

4. Onthe Log On tab, select This account and then click Browse.
5. Inthe Select User dialog box, click Locations.
6. Inthe Locations dialog box, select the domain that has the required account and then click OK.



7. Inthe Select User dialog box, in the Enter the object name to select box, type the domain user
name, suchas PIC RTSsvc, click Check Names, and then click OK.

8. Type the password for the user in the Password and the Confirm password fields and then click OK.

Configure the RTS Remote Administration MMC Snap-in

To configure the snap-in, complete the following steps.

1. Verify that the PIC Runtime Service Manager service is running. This lets you connect by MMC to the
machine.

2. Identify one free configurable port available in any TCP/IP network or the Internet across firewalls.

Note: The default port number is 50607 .

3. Verify one of the following prerequisites.
« The administration workstation resides on the same LAN segment as the RTS services.

« Inasub-netted network, a name resolution system is in place to allow clients on one subnet to
locate resources on another subnet.

4. Start PIC Runtime Service Management Console.

5. Inthe Runtime Server Administration window, in the left pane, right-click Runtime Server
Administration and click New RTS Group.

6. Inthe New Group dialog box, type a group name and click OK.

7. Openthe Runtime Server Administration node, right-click the newly created group, and then click
New Machine.

8. Inthe Group Management dialog box, complete the following substeps.
1. From the Domains list, select the required domain and then click Search.
2. Inthe left pane, select the required machines, click >> and then click OK.

9. Inthe Runtime Server Administration window, complete the following substeps.
1. Inthe left pane, right-click the newly added machine and then click License.
2. Inthe License Information dialog box, verify or change the license path and then click OK.
3. Inthe left pane, right-click the newly added machine and then click New > RTS Instance.
4. Inthe New RTS Instance dialog box, type an instance name and then click OK.

Configure the email import feature in Microsoft Outlook

You can optionally configure PIC to import emails from Microsoft Outlook. To configure the email import
feature, complete the following steps.

In Windows Control Panel, click Mail.

In the Mail dialog box, click Add.

In the New Profile dialog box, type RTS Import and then click OK.
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Inthe Add New Account dialog box, select Manually configure server settings or additional
server types and then click Next.

5. Inthe Choose Service page, select Microsoft Exchange or compatible service.
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6. Inthe Server Settings page, complete the following substeps.
1. Inthe Server field, type the name of your Microsoft Exchange Server.
2. Clearthe Use Cached Exchange Mode check box.
3. Inthe User Name field, type the user name and then click Next.

7. Tocreate the account and close the wizard, click Finish.

8. Inthe [Installation path]\Perceptive Intelligent Capture directory, create a new batch file that

contains the following line and then run the file.
DstHost.exe /TestMailUI

9. Inthe Outlook login dialog box, complete the following substeps.

1. Inthe User name field, type [domain name]\ [user name] and inthe Password field, type
the password.

2. Select Remember my credentials and then click OK.

10. From the [Installation path]\Perceptive Intelligent Capture\bin\Log directory, open the latest I_
[YYYYMMDD] DistillerRuntimeServiceHost_[PID].log file and check for a success or error
message, such as Managed to open the folder 'Inbox'.

11. Inthe [Installation path]\Perceptive Intelligent Capture directory, create a new batch file that

contains the following line and then run the file.
DstHost.exe /TestMail

Note: This writes a message to the log file, but does not open the Outlook login dialog box.

About the desktop heap size

If you run more than 10 concurrent Web Verifier sessions or Runtime Service instances, modify the Windows
desktop heap size to prevent internal memory issues.

Modify the desktop heap size
To modify the desktop heap size, complete the following steps.

Start Windows Registry Editor and back up the registry settings.

2. Navigate to [HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session
ManagenSubSystems].

3. Inthe right pane, right-click the Windows entry, and then click Modify.

4. Inthe Edit String dialog box, in the editing field, modify the third argument of the SharedSection
parameter, which defines the desktop heap size.

Note: For information about the appropriate heap size, see |deal desktop heap size.

5. Reboot the server.



|deal desktop heap size

Determine the ideal desktop heap size with the following table.

Number of concurrent Web Verifier or Runtime Server instances Desktop heap size in KB
1-10 Operating system default value
11-24 1024

25-36 1536

37-48 2048

49 -60 2560

61-72 3072

About logging

The standard Runtime Server log files include system level resource information and, in case of a system
failure, special error logs.

Application log files

Each log file contains the following information.

Entry Nr. Description

1 Type of message such as Info, Warning, or Error

2 Severity of message

3 Time logged

4 Process ID (PID)

5 Overall used/available physical memory in KB

6 Overall used/available virtual memory in KB

7 Used physical/virtual memory by this RTS instance in KB
8 Number of process handles used by this RTS instance




Entry Nr.

Description

9

GDI resources/UserObjects used by this RTS instance

10

Message text

The following log files are available in the [Installation path]\Perceptive Intelligent Capture\bin\Log directory.

Log file Description

name

V_*.log Verifier messages including custom script errors.

VA _*.log | Advanced Verifier messages.

VL*.log Local Verifier messages.

H_*.log Runtime Server Host (DstHost) messages for a single RTS instance.

L_*.log Learnset Manager messages, such as when the user triggers document learning, or backs up
the learnset.

D_*.log Designer messages including script errors.

U_*.log Web Verifier and external application messages.

S_*.log Service Manager (DstMgr) messages, such as start and end of service, restart, or failures.

|_*.log Component log files for all applications.

M_*.log System Monitoring (DstEvent) messages. Holds all system messages and can log error

messages across all server machines and hosts.




Error log files

In the event of system or application failures, PIC creates an additional error log file named C_<Process ID>_

yyyymmdd.log.
OCR engine languages

The following table lists the OCR engine languages supported by FineReader 10 and 11.

Supported OCR languages h2 h3
Bulgarian Italian Romanian
Chinese Simplified * Japanese * Russian *
Chinese Simplified + English * Japanese + English * Slovak
Czech Korean * Slovenian
Danish Korean + English * Spanish
Note: Only with FineReader 11
Digits KoreanHangul Swedish
Dutch Latvian Thai *
English Lithuanian Turkish
Estonian Norwegian Ukrainian *
Finnish NorwegianBokmal Vietnamese *
French NorwegianNynorsk CMC7
German Polish E13B
Greek * Portuguese Brazilian
Hungarian Portuguese Standard

*: These languages require support of double byte and extended ASCII character sets. To avoid performance

loss, do not use more than one DBCS language in a project.




Available OCR Engines

The following optional OCR engines are available, but require separate licensing.

Clegs Barcode Engine

Reads handwritten and machine-printed data and barcode information. It reads 18 types of bar codes.
FineReader10 OCR Engine

Supports Chinese, Korean and Japanese characters in addition to English, German, Italian, French, and
Spanish characters. Converts paper-based or scanned images to editable text.

FineReader11 OCR Engine

Supports OCR of several additional languages and features several improvements in the OCR output quality
relative to FineReader 10.

« Receipt Mode

« Improved auto-orientation

« Improved OCR of amounts with leading or trailing asterisks
« Improved OCR of amounts with leading dollar sign

Kadmos 5 OCR Engine Client Edition
Used for handwriting recognition.
Kadmos 5 OCR Engine Server Edition

A server edition capable of processing for multiple users and on multiple processors is available by additional
licensing.

QualitySoft Barcode Engine

Supports both grayscale and color images and recognizes 19 different barcode types.

About INI file encryption

PIC allows password encryption in an INI file for database and SAP connection strings by using RSA
encryption. RSA encryption contains a public and a private key.

For more information, see “Password encryption for database connection strings” in the Perceptive Intelligent
Capture Scripting Help.
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About automated update

You can enable your system to automate updates to your PIC workstations. The automated update feature
compares the build level files in the shared network directory and local update directory, and if required, an
update performs before the application starts.

If you did not configure the automated update feature during the installation process, you can configure the
feature manually.

Note: This feature is not available for all versions of PIC. For details, refer to the appropriate Perceptive
Intelligent Capture Release Notes.

Modify the batch file

To modify the batch file to automate updates, complete the following steps on each PIC server and
workstation.

Prerequisite

Determine a shared network directory on a server to incorporate the update files. All PIC workstations must
have access permissions to this directory.

1. From the [Installation path]\Perceptive Intelligent Capture\bin directory, open the Autolnstall.bat
file in a text editor.

2. Search for the following line.
SET SHAREDNETFOLDER =\\YourNetworkInstallServerName\YourInstallShareName

3. Modify \\YourNetworkInstallServerName\YourInstallShareName toyour shared network
directory.

4. Save and close thefile.

Modify the application shortcuts for PIC Verifier and PIC Designer

To set up PIC Designer and PIC Verifier to run the automated update feature each time they start, complete
the following steps.
In the Windows start menu, right-click the PIC Designer application and then click Properties.

2. Onthe Shortcut tab, in the Target field, change DstDsr.exe to DstDsr_AutoUpdate.bat and then click
OK.

3. Inthe Windows start menu, right-click the PIC Verifier application and then click Properties.

4. Onthe Shortcut tab, in the Target field, change DstDsr.exe to DstDsr_AutoUpdate.bat and then click
OK.

Automate Runtime Server updates

To configure the automated update for PIC Runtime Server, you can create a Windows task.
In Windows Task Scheduler, create a new task that executes the following steps.

1. Tostopthe RTS service, in [Installation path]\Perceptive Intelligent Capture\bin directory, run Stop
RTS running as NT Service.bat.
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Note: Verify that RTS is not actively processing documents before you stop the service.

2. In/[installation path]\Perceptive Intelligent Capture\bin directory, run Autolnstall.bat

3. Tostartthe RTS service, in [Installation path]\Perceptive Intelligent Capture\bin run Start RTS
running as NT Service.bat.

About port configuration

In case of a conflict in port assignments or for the purpose of firewall configuration, you can change the port
the Runtime Server uses for the TCP/IP communication channel.

The PIC Runtime Server service, the instance processes, and the MMC use the same Port registry setting.
The default port is 50607.

Configure a different port for PIC Runtime Server
To configure a different port for Runtime Server, complete the following steps.

1. InWindows registry, complete one of the following substeps.

1. For a 32-bit machine, right-click HKEY_LOCAL_MACHINE/SOFTWARE/Lexmark/Services
and then clickNew > DWORD (32-bit) Value .

2. Fora64-bit machine, right-click HKEY_LOCAL_
MACHINE/SOFTWARE/Wow6432Node/Lexmark/Services and then click New > DWORD
(32-bit) Value
2. Inthe Name field, type Port.
3. Right-click the Port key and then click Modify.

4. Inthe Edit DWORD (32-bit) Value dialog box, in the Value data field, type the number of an available
port and then click OK.

5. Restart the Perceptive Intelligent Capture Runtime Server service.
6. Repeat the previous steps on all PIC servers.

File permission matrix

The following tables list the various file permissions used within PIC.

Role/Group Description

Administrators Users with full access rights to all application modules and features.

Developers Users that develop, maintain, and enhance projects.

Learnset Typically one single user responsible for maintaining the project learnsets.

Manager

Advanced Several users responsible for identifying documents for improvements to the project




Role/Group Description

Verifiers learnset.

Standard Users responsible for document correction.

Verifiers

RTS Service The service account responsible for running the service for automatic document
User processing.

Configured only on the server machines.

The following table lists the required NTFS permissions.

Directory

Groups Full Modify | Read & List Read | Write | No
Control Execute Folder Access
Content

License
Share

Administrators | - - X X X X -

Developers

Learnset
Manager

Advanced
Verifiers

Standard
Verifiers

RTS Service
User

Common
Folder

Administrators | x X X X X X -

Developers

Learnset
Manager

Advanced

Verifiers

Standard - - - - - - X
Verifiers




Directory

Groups

Full
Control

Modify

Read &
Execute

List
Folder
Content

Read

Write

No
Access

RTS Service
User

Global
Project

Administrators

Developers

Learnset
Manager

RTS Service
User

Advanced
Verifiers

Standard
Verifiers

Local
Project

Administrators

Developers

Learnset
Manager

RTS Service
User

Standard
Verifiers

Advanced
Verifiers

Local
Learnset

Administrators

Developers

Learnset
Manager

RTS Service




Directory

Groups

Full
Control

Modify

Read &
Execute

List
Folder
Content

Read

Write

No
Access

User

Standard
Verifiers

Advanced
Verifiers

Global
Learnset

Administrators

Developers

Learnset
Manager

RTS Service
User

Advanced
Verifiers

Standard
Verifiers

ASE Pool

Administrators

Developers

RTS Service
User

Learnset
Manager

Advanced
Verifiers

Standard
Verifiers

ASSA
CSV File

Administrators

Developers




Directory | Groups Full
Control

Modify | Read & List Read | Write | No
Execute Folder Access
Content

RTS Service
User

Learnset -
Manager

Advanced
Verifiers

Standard
Verifiers

Web.config options and associated resource file parameters

This topic lists Web.config file options you can modify to enable, disable, or customize features.
For more information about the event options, refer to the Perceptive Intelligent Capture Scripting Guide.

Option

Description

ADOCommandExecutionTimeOut

Defines the timeout, in seconds, for executing stored procedures
in the database.
Possible values

Any valid integer

AllowAccessToDocumentsTolndexOnly

For more information, see About navigation to documents for
indexing.

Possible values

True: Enable navigation to indexable documents only

False: Enable navigation to out-of-workflow documents.

The default value is False.

BatchViewPageSize

Defines the number of batches per page that display in the PIC
Web Verifier batch list.
Possible values

Any valid integer
The default value is 20.

ClientSideDocumentCacheSize

Defines the number of pages to cache in the current document.
Possible values




Option

Description

Any valid integer

The default value is O.

connectionStrings

The database connection string.

DialogWidth

Defines the default width, in pixels, of message boxes in PIC
Web Verifier.
Possible values

Any valid integer
The default value is 400.

document cacheSize in the
<document.controller> element

Specifies the number of workdoc objects to pre-load. This
accelerates opening documents within the batch.

You cannot disable pre-loading, but minimize the number of pre-
loaded documents to 2, that means one current and one pre-
loaded.

Possible values

Any valid integer

The default value is 5.

document maxPagesToPreload in the
<document.controller> element

Defines the number of document pages to pre-load.

First and last pages always pre-load, and remaining cache slots
fill with pages that have field candidates starting from the lower
index.

The following actions take place on page images when a
document loads in the background.

« Pre-load the page

« Convert the page to PNG

« Save the page to the database
Possible values

Any valid integer

The default value is 5.

DocumentViewPageSize

Defines the number of folders for Verifier to display in the
document tree view when using Show Selected Batch mode.
Additional batches display in subsequent navigation panels.
Possible values

Any valid integer




Option

Description

The default value is 10.

EnableProfiler

Whether to enable the PIC Web Verifier profiler.

The profiler collects and records the duration of user actions,
such as commands and their internal sub-operations.
Possible values

True / False

The default value is False.

externalGroupldColumn

Whether the external group ID column displays in PIC Web
Verifier.
Possible values

True / False

The default value is False.

externalBatchNameColumn

Whether the external batch name column displays in PIC Web
Verifier.
Possible values

True/ False

The default value is False.

focusChanged

Whether to enables the focusChanged event for fields in the
verification view.

The event triggers when the user presses the Enter key in a field.

The setting has no effect on the FocusChanged event if the
<mouseClicked> attribute is set to true.
Possible values

True/ False

The default value is True.

HelpLink

Links to Web Verifier Help.

httpHeaderBasedSso

Controls the single sign-on (SSO) user authentication mode.

login header in the
<httpHeaderBasedSso> element

Corresponds to the HTTP header attribute name that contains
the SSO authenticated user name.

The SSO service uses this attribute to send the user name.

Enabled in the <httpHeaderBasedSso>

Whether to use the PIC Web Verifier SSO feature.




Option

Description

element

Possible values
True / False

The default value is False.

sessionHeader in the
<httpHeaderBasedSso> element

The provider-dependent name of the HTTP header that the SSO
service uses to send the user session ID.

inactiveUserTimeout

Unchangeable attribute.

Note: This attribute does not control the user session timeout.
The <sessionState Timeout> parametercontrols the
user session timeout.

inspectionTimeOut

Unchangeable attribute.

Note: This attribute does not control the user session timeout.
The <sessionState Timeout> parameter controls the
user session timeout.

instanceName The instanceName value displays in the batch list column “Last
Module".
Note: The instanceName value must be unique across all
installed Web Verifier servers accessing the same database.
itemCopied Whether to enable the itemCopied event.

Possible values
True / False

The default value is False.

LanguageDisplayName_[ISO]

Customizes the language display names in the language
selection menu.

Replace [ISO] by the three letter directory name in [Installation
path]\Perceptive Intelligent Capture Web Server\Bin\Resources.
Example for Simplified Chinese

<add key="LanguageDisplayName ZHO" value=" rh
i />

licensePath

The location of the shared license file.
Possible values




Option

Description

Any valid path

The default value is C:\Program Files
(x86)\Lexmark\License\Runtime.lic.

level

Defines the tracing level.
Possible values

DEBUG: Trace all information and error messages.

ERROR: Trace error messages only.

loadInSeparateProcess

Unchangeable attribute.

mouseClicked

Whether to enable the mouseClicked event on fields and tables
in the verification view in indexing mode.
Possible values

True / False

The default value is False.

pathToProjectExe

The location of the PIC Designer program
Brainware.System.Project.exe. In typical installations, it is not
required to modify this value.

Possible values

A valid non-UNC path ending with a “\”.

The default value is C:\Program Files (x86)\Lexmark\Perceptive
Intelligent Capture\Perceptive Intelligent Capture\Bin\.

ReinitScriptEngineAfterScriptErrors

Whether to recover the script engine after a script error in PIC
Web Verifier.
Possible values

True/ False

The default value is False.

remoteObjectRenewal Timeout

Defines, in seconds, the time to lapse before renewing remote
object references. The lower the number the faster unused
objects free memory. Increase this value in the event of errors
caused by long-running commands, such as field validation.
Possible values

Any valid integer more than or equal to 30.

The default value is 30.

SavePagelmageToDatabase

Specifies if page images extracted from document file blobs




Option

Description

needs to be saved back to the database.
Possible values

True / False

timeout in the <sessionState> element

Defines, in minutes, the amount of time a user can be inactive
before the session ends.

Specify a value less than that of the SSO session. For details,
see the product documentation of your SSO provider.
Possible values

Any valid integer.

The default value is 20.

ShowExtendedErrorMessages

Whether to enable stack trace information for PIC Web Verifier
error messages.

Error messages display in the trace log file.
Possible values

True/ False

The default value is False.

slogan

A text message that displays on the PIC Web Verifier browser
header, such as corporate messages, announcements, or the
corporate slogan.

Possible values

The default value is an empty string.

Example

<verifier.webclient>

<company slogan="This is a slogan" />

SYSTEM_LONG_DATE_FORMAT

The XML key available in each
Brainware.Verifier.WebClient.resx file located in [Installation
path\Perceptive Intelligent Capture Web Server\Bin\Resources\
[language code].

The key contains the date pattern for the last access date column
in the batch list for the respective language.

To use the default system date pattern, leave the value element
empty. The time format uses a 24-hour clock.

For Traditional and Simplified Chinese, use the date format in
the following example without any Chinese characters.
Example for Chinese




Option

Description

<data name="SYSTEM LONG DATE FORMAT"
xml : space="preserve">
<value>yyyy-MM-dd, hh:mm:ss</value>

</data>

transactionldColumn

Whether the transaction ID batch column displays in PIC Web
Verifier.
Possible values

True / False

The default value is False.

transactionTypeColumn

Whether the transaction type batch column displays in PIC Web
Verifier.
Possible values

True/ False

The default value is False.

tabPressed

Whether to enable the tabPressed event on fields and tables in
the verification view in indexing mode.
Possible values

True/ False

The default value is False.

tableCellSelected

Whether to enable the tableCellSelected event.
Possible values

True / False

The default value is False.

usePath

Possible values
True: Use the pathToProjectExe parameter.

False: Use the current directory instead of the pathToProjectExe
parameter.

The default value is True.

waitLoadTimeOut

Defines the timeout for the initial loading of the project.exe.




About navigation to documents for indexing

Indexable documents are documents with states from enabled workflow input states. The Web.config option
AllowAccessToDocumentsToIndexOnly and the Web Verifier option “Disable navigation to valid
documents” control the navigation to indexable documents.

Example

Workflow settings: 550 -> 700
A batch includes documents with states 550, 600, and 700.

If youset AllowAccessToDocumentsToIndexOnly to True and activate the "Disable navigation to valid
documents" option in Web Verifier, you cannot access documents with state 600 or 700.

Enable navigation to indexable documents

To enable navigation to indexable documents only, complete the following steps.

1. From the [Installation path]\Perceptive Intelligent Capture Web Server directory, open Web.config in a
text editor.

2. Searchfor<appSettings>.

3. Addthe foIIowinP line.
<add key="ATlowAccessToDocumentsToIndexOnly" value="true" />

4. Save and close the file.

5. InWeb Verifier, activate the Disable navigation to valid documents option.

Registry options

You can create or modify the following keys in the Windows registry to enable, disable, or customize features.

Key

Description

ErrorTraceDir

Provides the possibility to change the component log file location. The
setting does not affect the core product log file location.

HideBatchReleaseDialog

Allows you to enable or disable the Batch Release dialog box within the
PIC Verifier, where the workflow does not require prompting users to the
next task. The registry value determines the next action carried out by
users.

The default action of the Batch Release dialog box is to verify the next
invalid batch. When PIC suppresses the dialog, this value is maintained.
To change to a different action, use the Batch Release dialog box once,
then change the setting accordingly and click OK.

The default value is 0.
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Key

Description

ErrorTrace - All

Defines the trace level.
The default value is 1.

MaximumDiskspaceUsageMB

Defines the disk space in MB allocated for component level logs.

TotalDaysToKeepFiles

Defines the number of days the PIC server retains the component log files.

Create the registry key ErrorTraceDir

To create the registry key, complete the following steps.

1.

o kw b

In Windows Registry Editor, complete one of the following substeps.

« Fora 32-bit machine, navigate to [HKEY LOCAL MACHINE\SOFTWARE\Lexmark\ErrorTrace)].

« Fora64-bit machine, navigate to [HKEY LOCAL _
MACHINE\SOFTWARE\Wow6432Node\Lexmark\ErrorTrace].

In the right pane, right-click and then click New > String Value.

Inthe Name field, type ErrorTraceDir and then click OK.

Right-click the ErrorTraceDir key and then click Modify.

In the Edit String dialog box, in the Value data field, type the path and then click OK.

Note: The path must exist and the service account / user needs write permission to the path.

6. Restart all PIC applications and services.

Create the registry key HideBatchReleaseDialog

To create the registry key, complete the following steps.

1.

o kw b

In Windows Registry Editor, complete one of the following substeps.

« Fora 32-bit machine, navigate to [HKEY LOCAL MACHINE\SOFTWARE\Lexmark\Cedar] .

« Fora64-bit machine, navigate to [HKEY LOCAL _
MACHINE\SOFTWARE\Wow6432Node\Lexmark\Cedar].

steps and then click OK.

In the right pane, right-click and then click New > DWORD (32-bit) Value.

In the Name field, type HidebatchReleaseDialog and then click OK.

Right-click the HidebatchReleaseDialog key and then click Modify.

In the Edit DWORD (32-bit) Value dialog box, in the Value data field, complete one of the following

« Todisplay the confirmation screen, type zero: 0.

« Tohide the confirmation screen, type 1.

Restart all PIC applications.
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Modify the registry key ErrorTrace - All
To modify the value, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.

« Fora 32-bit machine, navigate to [HKEY LOCAL MACHINE\SOFTWARE\Lexmark\ErrorTrace] .

« Fora64-bit machine, navigate to [HKEY _LOCAL _
MACHINE\SOFTWARE\Wow6432Node\Lexmark\ErrorTrace].

2. Intheright pane, right-click All and then click Modify.

3. Inthe Edit DWORD (32-bit) Value dialog box, in the Value data field, complete one of the following
steps and then click OK.

« Tologonly errors, type 1.
« Tologonly errors and wamings, type 2.
« Tologonly errors, warnings, and information, type 3.
Create the registry key MaximumDiskspaceUsageMB

To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.

« Fora 32-bit machine, navigate to [HKEY _LOCAL MACHINE\SOFTWARE\Lexmark\ErrorTrace] .

« Fora64-bit machine, navigate to [HKEY LOCAL _
MACHINE\SOFTWARE\Wow6432Node\Lexmark\ErrorTrace] .

In the right pane, right-click and then click New > DWORD (32-bit) Value.
In the Name field, type MaximumDiskspaceUsageMB.
Right-click the MaximumDiskspaceUsageMB key and then click Modify.

In the Edit DWORD (32-bit) Value dialog box, in the Value data field, complete one of the following
steps and then click OK.

o kb

« Todeactivate the option, type zero: 0.
« Type the appropriate value in megabyte.

Create the registry key TotalDaysToKeepFiles
To create the registry key, complete the following steps.

1. InWindows Registry Editor, complete one of the following substeps.

« Fora 32-bit machine, navigate to [HKEY LOCAL MACHINE\SOFTWARE\Lexmark\ErrorTrace] .

« Fora 64-bit machine, navigate to [HKEY _LOCAL
MACHINE\SOFTWARE\Wow6432Node\Lexmark\ErrorTrace].

2. Intheright pane, right-click and then click New > DWORD (32-bit) Value.
3. Inthe Namefield, type TotalDaysToKeepFiles.
4. Right-click the TotalDaysToKeepFiles key and click Modify.
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5. Inthe Edit DWORD (32-bit) Value dialog box, in the Value data field, complete one of the following
steps and then click OK.
« Todeactivate the option, type zero: 0.

« Type the number of days.
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